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RESUMO

OBJETIVO: Analisar a concordancia intra e interavaliadores das medidas
ultrassonogréficas do deslocamento do osso hioide durante a degluticio. METODO:
Trata-se de um estudo transversal do tipo diagnéstico, com enfoque na analise de
concordancia interpessoal e intrapessoal com abordagem quantitativa. Trés juizes
treinados analisaram exames de Ultrassonografia Laringea Transcutanea (USGLT)
de 20 individuos do sexo feminino sem alteracdes de degluticdo, com idades entre
19 e 68 anos. De cada exame, 0s juizes extrairam de forma independente e por
meio de método padronizado seis medidas quantitativas de tempo, amplitude e
velocidade do deslocamento do osso hioide durante a degluticdo de consisténcia
liguida e liquida espessada (honey), o que gerou um total de 240 imagens. Foi
realizada analise de concordancia intra e interavaliadores por meio das estimativas e
intervalos de confianca (95%) do Coeficiente de Correlacdo Intraclasse (CCI),
seguindo modelos aleat6rio e misto de duas vias, tipo concordancia absoluta e
analise das medidas médias. RESULTADOS: na andlise de concordancia intra-
avaliador o juiz com melhor desempenho apresentou seis medidas com CCI entre
moderado e excelente. Na andlise de concordancia entre os trés avaliadores a
medida de velocidade e as medidas temporais de elevagcdo, anteriorizacao,
deslocamento maximo e manutencdo do deslocamento maximo tiveram CCI
classificados como bons. Medidas de tempo de retorno, tempo total de
deslocamento e as medidas de amplitude da excursdo do 0sso hioide apresentaram
baixas estimativas de confiabilidade. As medidas temporais de elevacdo e
deslocamento maximo foram as que apresentaram desempenho mais consistente
nas analises de concordéancia intra e interavaliadores. Os intervalos de confianca

muito amplos evidenciaram baixa precisdo de todas as medidas. CONCLUSAO: a



confiabilidade das medidas ultrassonograficas de deslocamento do osso hioide apoés
a degluticdo foram classificadas, em sua maioria, como moderada na analise intra-
avaliador e boa na analise interavaliadores. A concordancia intra-avaliador possui
estimativas mais confiaveis quando comparada a concordancia entre avaliadores. As
medidas temporais sdo as mais confiaveis, especialmente o tempo de elevacao e o
tempo de deslocamento maximo do osso hioide. Contudo, as estimativas de

concordancia das medidas investigadas ndo tém precisao.

Descritores: 0Osso hioide. Degluticdo. Ultrassonografia. Reprodutibilidade dos

Testes.



INTRODUCAO

A degluticdo depende de um fino controle neurofisiolégico e da acao
complexa de interacdo entre muasculos do aparelho respiratério e do trato
gastrointestinal impulsionando alimentos, saliva, secre¢cdes ou particulas a partir da
via oral até o estbmago (MILLER, 1986; SHAWKER et al., 1984). O
comprometimento neuroldgico, mudancas estruturais nas regibes de cabeca e
pescoco e/ou doencgas progressivas podem ocasionar alteracfes na biomecanica da
degluticdo causando disfagia, um sintoma cujas sequelas envolvem impactos
negativos na nutricdo, hidratacdo, condicdo pulmonar e qualidade de vida
(MOLFENTER; STEELE, 2012).

Um dos componentes essenciais da biomecanica da degluticdo € o
movimento de elevacdo e anteriorizacdo do o0sso hioide, que se inicia na fase
faringea pela contracdo coordenada de grupos musculares da regido suprahioidea e
relaxamento dos musculos infrahioideos (CHEN et al., 2017; KRUIS et al., 2011;
LOGEMANN, 1997). O deslocamento do o0sso hioide ocorre simultaneamente ao
deslocamento da laringe, sendo fundamental para o adequado fechamento do adito
laringeo (elevacdo) e posterior relaxamento do segmento faringoesofagico
(anteriorizacéo), causado pela contracdo do musculo geniohioideo e consequente
geracdo de pressdo na regido cricofaringea (LEE et al., 2016; HUANG et al., 2009;
LOGEMANN, 1984).

Alguns estudos demonstram que pacientes com disfagia possuem menor
amplitude de deslocamento do complexo hiolaringeo em relacdo a individuos
saudaveis (BACELETE; VICENTE; SANTOS, 2016; HSIAO et al., 2012; LEE et al.,
2016). Este evento pode, por exemplo, interferir no relaxamento do segmento

faringoesofagico e assim favorecer a formagcdo de residuo faringeo apés a



degluticdo, aumentando também os riscos de penetracédo e aspiracdo (LEE et al.,
2016).

Quase todos os estudos metodolégicos adotam o 0sso hioide como ponto
anatbmico de interesse para analisar a degluticdo, principalmente em exames
instrumentais como a videofluoroscopia da degluticdo (VFD), considerado o exame
padrao de referéncia utilizado para avaliar a degluticdo e suas possiveis alteracdes
(COSTA, 2010; OZAKI et al., 2010; PALMER et al., 1993). Contudo, a VFD consiste
em um meétodo pouco pratico no dia a dia e muitas vezes indisponivel nos servicos
de saude, sendo inevitavel a exposicéo a radiacédo e a utilizacdo de contraste, além
de execucdo invidvel se o paciente ndo puder se deslocar até a sala de Radiologia
(AHN et al., 2015; HUANG et al., 2009; KUHL et al., 2003).

Portanto, outras tecnologias tém sido testadas para superar essas limitacoes,
pelo menos parcialmente. Uma delas é a Ultrassonografia (USG), um procedimento
nao invasivo, sem emissdao de radiacdo ionizante, que pode ser realizado com
pacientes no leito utilizando alimentos reais sem contraste. A USG permite a
observacdo do osso hioide por meio da identificacdo da sombra acustica gerada por
essa estrutura e possibilita a obtencdo de medidas quantitativas relacionadas ao
deslocamento do osso hioide durante a degluticdo (AHN et al., 2015; HUANG et al.,
2009; HSIAO et al., 2012; KUHL et al., 2003).

Uma das alternativas ultrassonograficas para investigacdo do deslocamento
hioideo durante a degluticdo é a Ultrassonografia Laringea Transcutanea (USGLT),
que possibilita a analise quantitativa de medidas temporais, de amplitude e
velocidade (RAGLAND et al., 2016; MERINO; AMBROS, 2019; LEE et al., 2016).

Ainda que essas medidas parecam promissoras, 0os dados na literatura ainda séo



escassos e demonstra a necessidade de estudos que possam contribuir para a
generalizacao da confiabilidade e precisdo do procedimento (AHN et al., 2015).

Nesse sentido, os estudos que usaram a USGLT para investigar o
deslocamento do osso hioide durante a degluticdo ndo evidenciaram a avaliacdo da
concordancia intra e interavaliadores das medidas quantitativas geradas pelo
exame, aspectos essenciais para determinar a confiabilidade de um método (MIOT,
2016; KOO, LI, 2018). Por meio da analise de concordancia € possivel verificar a
capacidade de diferentes avaliadores ou dos mesmos avaliadores em momentos
diferentes aferirem de maneira semelhante um determinado fenémeno (MATOS;
2014; MIOT, 2016). Sem esse tipo de andlise ndo é possivel confiar nas
mensuracdes obtidas e nem tirar conclusées racionais baseadas nas mesmas
(KOO, LI, 2018).

Portanto, o objetivo deste estudo foi analisar a concordancia intra e
interavaliadores das medidas ultrassonogréaficas do deslocamento do osso hioide
durante a degluticdo. A hip6tese deste estudo afirmava que as estimativas de

concordancia variavam entre moderada e excelente.
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METODO

Trata-se de um estudo do tipo diagnostico e transversal, com enfoque na
analise de concordancia interpessoal e intrapessoal com abordagem quantitativa.
Foi realizado no Laboratério de Estudos em Degluticdo e Disfagia (LEDDis/UFPB)
vinculado ao Departamento de Fonoaudiologia da Universidade Federal da Paraiba
(UFPB) e desenvolvido no periodo de novembro de 2018 a setembro de 2019.

Os exames sao oriundos de coletas realizadas no Servico de Cirurgia de
Cabeca e Pescoco do Hospital Universitario Lauro Wanderley (HULW/EBSERH/
UFPB) e vinculados a um projeto de pesquisa estruturante. Este foi aprovado pelo
Comité de Etica em Pesquisa do Hospital Universitario Lauro Wanderley, sob o
parecer 2.314.731/18, respeitando o disposto na Resolucédo 466/2012, do Conselho
Nacional de Educacéo (CNE).

As variaveis deste estudo estdo descritas no quadro 1 e foram compostas
pelas medidas de tempo, amplitude e velocidade do deslocamento do osso hioide
durante a degluticdo. O método de aquisi¢do e analise das medidas de tempo foram
convencionadas no estudo de Rodrigues (2018). As medidas de distancia foram
baseadas na proposta de Freitas (2017) e a medida de velocidade foi baseada no

estudo de Ragland et al. (2016). Todas as medidas estdo descritas no quadro 1.
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Quadro 1 — Medidas de tempo, amplitude e velocidade do deslocamento do osso hioide

durante a degluticdo que compdem as variaveis do estudo.

Nome da variavel

Definicao

Categoria/Esca

la

Distancia de Elevacéo
Maxima do Osso Hioide

(DEMOH)

Distancia do repouso até o ponto
méaximo de elevacao do 0sso hioide

durante a degluticao

Em centimetros

(cm)

Distancia de

Deslocamento Maximo

Distancia do repouso até o ponto

maximo de anteriorizacdo durante a

Em centimetros

do Osso Hioide (cm)
degluticédo
(DDMOH)
Duracgao do tempo que vai do
primeiro frame onde o hioide inicia Em

Tempo de Elevacao do

Osso Hioide (TEOH)

movimento de ascensao, até o

milissegundos

Tempo de Anteriorizagao

do Osso Hioide (TAOH)

frame anterior ao inicio da (ms)
anteriorizacao
Duracgao do tempo entre o primeiro
frame de deslocamento diagonal do
Em

hioide em direcao a regido anterior

até o primeiro frame que representa

milissegundos

(ms)
a estabilizacdo do osso hioide na
posicdo de maxima anteriorizacao
Tempo de Deslocamento | Duragdo do tempo entre 0 repouso Em

Maximo do Osso Hioide

e a maxima anteriorizacdo do 0sso

milissegundos
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(TDMOH) hioide (ms)
Tempo de Manutengéo
Duracéo do tempo entre o frame
do Deslocamento Em

Maximo do Osso Hioide

posterior ao da maxima

anteriorizacdo do hioide e o frame

milissegundos

(TMDMOH) (ms)
anterior ao inicio do retorno do
hioide para a posic¢éo inicial
Duracéo do tempo entre o frame no
gual o hioide sai da manutencéo da
Tempo de Retorno do Em

Osso Hioide para o

anteriorizagdo até o primeiro frame

do momento em que o hioide

milissegundos

Repouso (TROHR) (ms)
mantém o repouso apos a
degluticao
Duracéo do tempo entre o primeiro
Tempo Total de frame correspondente a elevacao Em

Deslocamento do Osso

Hioide (TTDOH)

do o0sso hioide e o primeiro frame
gue mostra 0 0sso hioide de volta a

posicéo de repouso

milissegundos

(ms)

Velocidade (V)

Velocidade de excursdao maxima do
hioide a partir da equagéao:

_ DDMOH (cm)
~ TDMOH (s)

Em centimetros

por segundo

)
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A amostra foi constituida pelos exames de USGLT gravados em video
arquivados no Laboratorio de Estudos em Degluticio e Disfagia da UFPB
(LEDDis/UFPB). Foram excluidos exames cujas imagens tivessem artefatos que
impossibilitassem a visualizacdo do osso hioide ou imagens que ndo permitissem a
avaliacdo de todas as medidas.

Assim, foram incluidos 20 exames de individuos com idade entre 19 e 68
anos (40,75+15,92), todos do sexo feminino, sem queixas de disfagia. Cada exame
era composto por nove videos referentes a degluticbes de saliva, consisténcia
liguida e liquida pastosa (honey), com trés repeticdes cada um. Para cada individuo
foram selecionadas as imagens da segunda degluticdo da consisténcia liquida e a
segunda degluticdo da consisténcia liquida espessada (honey). Para realizacdo da
analise de concordancia intra-avaliador 20% dos individuos foram selecionados de
maneira aleatoria. Portanto, os juizes analisaram, no total, 48 exames.

Todos os participantes foram avisados previamente dos procedimentos e
assinaram voluntariamente o Termo de Consentimento Livre e Esclarecido,
autorizando a utilizacdo dos dados para fins de pesquisa. A USGLT sempre foi
executada pelo mesmo médico cirurgido de cabeca e pesco¢o com experiéncia em
ultrassonografia cervical juntamente com uma fonoaudidloga. Foi utilizado o
equipamento USG LOGIQ P6 (GE Healthcare®; lllinois, Chicago). A aquisicdo e
analise da USGLT foi realizada de acordo com a proposta apresentada por
Rodrigues (2018).

Na fase de aquisicéo, 0s pacientes passaram pelas seguintes etapas:

Etapa 01 — O individuo foi posicionado sentado numa cadeira, seguindo 0

plano de Frankfurt, com apoio plantar. Em relacdo ao posicionamento de cabeca, o
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paciente foi orientado a manter um angulo de noventa graus (90°) do assoalho bucal
com o pescoco, aproximando-se da posicao funcional de degluticao;

Etapa 02 — Um transdutor convexo em contato com uma camada de gel
hidrossoluvel foi posicionado transversalmente na por¢ao mediana da regido cervical

anterior (Figura 1a);

Figura 1 - a) Procedimento de captacdo da imagem ultrassonografica da laringe; b)
imagem ultrassonogréafica no modo B. Seta vermelha indica a imagem hiperecoica do
0sso hioide. Linhas pontilhadas mostram o contorno da sombra acustica hipoecoica que

acompanha o 0sso hioide.

Etapa 03 — O equipamento de USG foi ajustado no modo B (modo de
processamento de eco do equipamento) e calibrado para cada voluntario em relagcéo
a brilho e contraste de forma a obter a melhor visualizacdo da imagem hiperecoica

do osso hioide e a sombra acustica hipoecoica produzida pelo mesmo (Figura 1b);

Etapa 04 — O individuo foi solicitado a seguir uma sequéncia de trés tarefas
de degluticdo, nesta ordem: saliva, 10 mililitros (mL) de liquido (dgua) e 10 mL de
liquido espessado (honey). Para preparar o liquido espessado foi usado espessante
a base de maltodextrina com amido de milho modificado em quantidade
recomendada pelo fabricante (1 %2 colher de sopa para 100 mL de agua).

Acrescentou-se ainda o correspondente a uma colher de medida de 1 mL de suco
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em po sabor péssego. Os materiais utilizados estdo na figura 2. Em todas as tarefas,
o voluntéario foi orientado a manter o conteddo na cavidade oral e deglutir apenas
sob o comando do avaliador. Cada tarefa foi repetida trés vezes, com intervalo de 30

segundos entre cada oferta.

o
W [ hick B
|| GEasy “ |

Figura 2 - Materiais utilizados para o preparo das consisténcias liquida e liquida
espessada na avaliacdo ultrassonografica do deslocamento do osso hioide durante a

degluticao.

Etapa 05 — Os exames de USGLT gravados originalmente pelo equipamento
no formato .wmv, com taxa de 30 quadros por segundo, foram salvos em um

dispositivo com entrada USB para a analise posterior.

ApOs estas etapas, foi realizada uma triagem no banco de videos e imagens
de USGLT em busca das unidades que cumprissem os critérios de elegibilidade. Em
seguida, um pesquisador cego em relacdo as informagbes sobre 0s pacientes

transformou os videos em arquivos de imagens, para analise quadro a quadro. Os
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videos foram decompostos em imagens utilizando o software gratuito Free Video to

JPG Converter, conforme descrito em Rodrigues (2018).

O mesmo pesquisador salvou os arquivos de imagens em pastas individuais
sem identificacdo nominal, codificadas apenas numericamente. Essas pastas foram
encaminhadas para trés juizes previamente treinados para andlise de imagens
ultrassonograficas da degluticdo. Dois juizes eram fonoaudidlogos com experiéncia
prévia nesse tipo de analise de imagem e o outro juiz era estudante de
Fonoaudiologia sem experiéncia prévia. Cada juiz extraiu independentemente as
medidas de tempo, amplitude e velocidade do deslocamento do osso hioide durante

a degluticdo, de acordo com as etapas a seguir:

Etapa 01 — Os videos ja decompostos em quadros foram abertos no software

gratuito ImageJ (National Institutes of Health, Bethesda, MD) conforme a sequéncia

- ¢ Imagel = ‘Eb
! Tmage) = ) - -
e - — Edit Image Process Analyze Plugins Window Help
- o NF T . | | | 1ot
i3 Edit Image Process Analyze P‘lugms Window Heo‘ ‘ ‘ R lalaleiO] Qled #]8 ]2 |

New ’ A‘ Q[ Qloe 4| 8| A 1 [ > | open Ctri+O  Jeh. double click to conbi
Open Cti+Q gt click to swalch) Open Next Clel+Shit+O
Open Next Clrl+Shit+O Open Samples ’
Open Samples 4 Open Recent LJ
Open Recen » Cimport | image Seqence |
import k Close ctew | Raw

c ! I v | LT
Close Ctri+W Close Al Ctrl+ Shift+ W

Save Cur+S Text Image.
Close Al Ctrl+Shifte W e 5 5

SamAS ,| TextFile
Save CirisS Results

Revert CrvR
Save As 4 Table.
Revert CtrivR EAne Selp URL

Print Cri+P | oo 2
Page Setup Stack From List
Print Ciri+P Quit TIFF Virtual Stack

AV

Quit XY Coordinates.

Passo 01: Abrir o programa em seguida “File > Import > Image Sequence > Sequence Options > OK.



| 22| Open Image Sequence... )
Examinar: Image06 (13-09-2018 10-24-10) - @7 m-
=b
. - - - -
J—_ Imagel6 001 Image06 002 Imagedé 003 Imaged6 004
Trabalho
.
o - - - -
@ Imageds 005 Image06 006 Imaged6 007 Image06 008
Computador g
Nome: Image06 001 ~ i
o
t‘#, Tipo [ Todos os Amquivos () ~| | Cancelar |

Passo 02: Selecionar a primeira imagem
dentro da pasta criada anteriormente, com as
imagens previamente convertidas no “Free

Video to JPG Converter”, na etapa de

conversao.
{ Image) = 2
File Edit Image Process Analyze Plugins Window Help
Bolc|o|~4l:=A|ala|o|O ale ]| 2] | |»
¢ Image06 (13-09-2018 10-24-10) = | B )

17175 (Imag=06 001); 640480 pixsls; RGB; 205MB

4 Imagel =
File Edit Image Process Analyze Plugins Window Help
I8 o x| o | <z N[ Al o [] ] Qo 4]0 ]2] | \--‘

Number of images.

Starting

I~ Convertto RGB
¥ Soitnames numerically

I Use virtual stack

640 x 480 x 175 (205.1MB)

ok | _cancat | e |

Passo 03: Na caixa de dialogo clicar em “Ok

17

1/152 (Image16 001), 640x480 pixels; RGB; 178MB

Image16 (14-09-2018 09-46-41) 2| E )

Passo 04: A sequéncia de imagens surgira.
Com as setas da barra de rolagem inferior a
imagem é possivel analisar o movimento de

deslocamento do osso hioide quadro a quadro.

Passo 05: As estruturas de interesse séo
identificadas: Osso hioide e sombra acustica
hipoecoica gerada. Acompanha-se 0 movimento
de deslocamento quadro a quadro, marcando-
se 0 movimento inicial de anteriorizagéo e
registra-se o quadro onde foi iniciado o

movimento.
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Etapa 02 — Para verificar as medidas temporais (TEOH, TAOH, TDMOH,
TMDMOH, TROHR E TTDOH), em segundos (s), foram definidos os quadros inicial
e final de quatro eventos: elevacédo, anteriorizacdo, manutencao da anteriorizacao e
retorno para o repouso. Como cada quadro corresponde a 0,03 segundos (30

quadros/s), multiplica-se o resultado por 0,03 para obter a medida temporal.

Etapa 03 — Para extrair as medidas de amplitude (DEMOH e DDMOH), em
centimetros (cm), foi desenhada uma linha de 8 centimetros (cm) sobre a escala
numeérica lateral apresentada na tela do exame, conforme recomenda Freitas (2017).
Em seguida foram procedidos os seguintes comandos: Analyze > Set Scale >
Known distance = 8 > Unit of lenght = cm > OK.

Ainda no quadro inicial foi feita a marcacao na regido posterior do 0sso hioide
e tracada uma linha deste ponto ao lado esquerdo. Em seguida, os frames foram
adiantados até encontrar aqueles que representavam o ponto maximo de elevacao
do osso hioide, estabelecendo a DEMOH e até o ponto maximo de anteriorizacao,
fornecendo a DDMOH. Os valores em centimetros foram obtidos a partir do

comando Ctrl + M.

Etapa 04 — Para extrair a medida de velocidade de excursdo maxima do

hioide, em centimetros por segundo (%), foi realizado o calculo utilizando os dados

fornecidos pela DDMOH, em centimetros (cm), e do TDMOH, em segundos (s), por

DDMOH (cm)
TDMOH (s)

meio da equacéo: V =
Cada juiz preencheu um banco de dados especifico com todas as medidas e
0 encaminhou para o0 mesmo pesquisador que realizou a selecdo e decomposicao

dos videos. Para a andlise de concordancia foram obtidas as estimativas do
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Coeficiente de Correlacdo Intraclasse (CCl) e seus respectivos intervalos de
confianca de 95%, seguindo o modelo aleatorio de duas vias para andlise
interavaliadores e o modelo misto de duas vias para analise intra-avaliadores. Em
ambos os modelos foi adotado o CCI tipo concordancia absoluta com analise de
medidas médias. As estimativas de concordancia foram classificadas como baixa
(menor que 0.5), moderada (entre 0.5 e 0.75), boa (entre 0.75 e 0.9) ou excelente

(acima de 0.9), de acordo com a classificacdo sugerida por Koo e Li (2016).
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RESULTADOS

A tabela 1 apresenta os resultados da analise de concordancia intra-avaliador,
na qual o mesmo juiz analisou o mesmo exame em momentos diferentes. O juiz 1
teve o melhor desempenho geral considerando que as seis estimativas de
confiabilidade que ficaram acima de 0,5 oscilaram entre 0,75 (moderado) e 0,92
(excelente). Além disso, este foi 0 juiz que apresentou intervalos de confianca com
amplitude mais reduzida em relacdo aos demais juizes, ou seja, foi aquele cujos

resultados tiveram mais precisao.

Tabela 1 — Analise de concordéancia intra-avaliadores das medidas ultrassonograficas de

tempo, deslocamento e velocidade do osso hioide durante a degluticéo.

CCI (IC 95%)

Medidas
Juiz 1 Juiz 2 Juiz 3

TEOH 0,92 (0,67-0,98) 0,65 (-1,12-0,93) 0,85 (0,25-0,97)
TAOH 0,75 (-0,09-0,95) 0,58 (-1,44-0,91) 0,29 (-2,80-0,86)
TDMOH 0,90 (0,55-0,98) 0,66 (-1,00-0,93) 0,81 (0,09-0,96)
TMDMOH 0,89 (0,39-0,98) 0,00 (-0,86-0,70) 0,92 (0,65-0,98)
TROHR 0,18 (-1,07-0,79) 0,90 (0,54-0,98) 0,71 (-0,67-0,94)
TTDOH 0,06 (-1,25-0,76) 0,88 (0,46-0,97) 0,73 (-0,45-0,94)
DEMOH 0,82 (0,19-0,96) 0,27 (-1,68-0,84) 0,14 (-4,42-0,83)
DDMOH 0,17 (-4,13-0,84) 0,49 (-2,57-0,90) 0,64 (-0,33-0,92)
VEL 0,90 (0,55-0,98) 0,18 (-2,48-0,83) 0,81 (0,18-0,96)

Legenda: CCIl = Coeficiente de Correlagéo Intraclasse; IC = intervalo de confianca; TEOH = Tempo
de elevacgédo do osso hioide; TAOH = Tempo de anterioriza¢do do osso hioide; TDMOH = Tempo de
deslocamento maximo do osso hioide; TMDMOH = Tempo de manutencao do deslocamento maximo

do osso hioide; TROHR = Tempo de retorno do osso hioide para o repouso; TTDOH = Tempo total de
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deslocamento do osso hioide; DEMOH = Distancia de Elevagdo Maxima do Osso Hioide; DDMOH =

Distancia de Deslocamento Maximo do Osso Hioide; VEL = velocidade.

Embora o juiz 3 tenha apresentado estimativas de confiabilidade acima de 0,5
em sete das nove medidas, os intervalos de confianca foram mais amplos em
comparacao ao juiz 1. Ja o juiz 2 foi o que apresentou pior desempenho com
estimativas de confiabilidade mais baixas e intervalos de confianca muito amplos
comparado aos demais. Ao contrario dos outros, esse juiz apresentou bons
coeficientes nas medidas TROHR e TTDOH. De forma geral, as estimativas de
confiabilidade intra-avaliador foram mais consistentes nas medidas temporais, em
especial nas medidas TEOH, TDMOH e TMDMOH.

Na tabela 2, observa-se a andlise de concordancia interavaliadores
comparando os trés juizes simultaneamente. Constatou-se que as medidas TEOH,
TAOH, TDMOH, TMDMOH e VEL tiveram estimativas de CCI classificadas como
boas, com coeficientes que variaram de 0,55 a 0,71. As medidas TROHR, TTDOH e
as duas medidas de amplitude apresentaram estimativas baixas de confiabilidade.

Ja na analise por pares, as estimativas do juiz 1 versus juiz 2 foram as mais
consistentes e reproduziram o mesmo padrdo do cruzamento entre os trés juizes,
com variagdo entre 0,54 e 0,72. As medidas TEOH e TDMOH mostraram as
estimativas mais estaveis, pois foram as unicas classificadas como “boas” em todos
0S cruzamentos realizados, ainda que os intervalos de confianca tenham sido
amplos. Porém, no caso do TEOH a variacao foi entre 0,50 e 0,72 e no TDMOH foi
de 0,51 a 0,72. Embora nas analises por pares tenham sido encontradas duas
estimativas de confiabilidade moderadas (0,77 para TMDOH e 0,82 para DDMOH)

cada uma surgiu apenas em um dos cruzamentos realizados.
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Tabela 2 — Analise de concordancia interavaliadores das medidas ultrassonogréficas de

tempo, deslocamento e velocidade do osso hioide durante a degluticéo.

Medidas

CCI (IC 95%)

Juiz 1 X Juiz 2 x

Juiz 3

Juiz 1 X Juiz 2

Juiz 1 X Juiz 3

Juiz 2 X Juiz 3

TEOH

TAOH

TDMOH

TMDMOH

TROHR

TTDOH

DEMOH

DDMOH

VEL

0,67 (0,40-0,83)
0,50 (0,10-0,74)
0,71 (0,47-0,85)
0,71 (0,40-0,86)
0,32 (-0,14-0,63)
0,19 (-0,33-0,56)
0,03 (-0,06-0,20)
0,28 (-0,05-0,60)

0,55 (0,07-0,79)

0,72 (0,41-0,86)
0,54 (0,03-0,78)
0,72 (0,41-0,86)
0,64 (0,26-0,82)
-0,04 (-0,81-0,44)
-0,23 (-1,16-0,35)
-0,05 (-0,16-0,15)
0,13 (-0,09-0,45)

0,61 (-0,18-0,85)

0,50 (-0,02-0,76)
0,20 (-0,66-0,62)
0,62 (0,16-0,82)
0,48 (-0,16-0,77)
0,42 (-0,13-0,71)
0,37 (-0,22-0,69)
0,75 (0,50-0,88)
0,82 (0,58-0,92)

0,59 (0,16-0,80)

0,52 (0,04-0,76)
0,36 (-0,29-0,69)
0,51 (-0,01-0,76)
0,77 (0,24-0,91)
0,47 (-0,03-0,73)
0,45 (-0,06-0,72)
-0,03 (-0,13-0,13)
0,16 (-0,09-0,49)

0,19 (-0,19-0,52)

Legenda: CCI = Coeficiente de Correlagéo Intraclasse; IC = intervalo de confian¢a; TEOH = Tempo

de elevacgdo do osso hioide; TAOH = Tempo de anterioriza¢do do 0sso hioide; TDMOH = Tempo de

deslocamento maximo do osso hioide; TMDMOH = Tempo de manutencao do deslocamento maximo

do osso hioide; TROHR = Tempo de retorno do 0sso hioide para o repouso; TTDOH = Tempo total de

deslocamento do osso hioide; DEMOH = Distancia de Eleva¢cdo Méxima do Osso Hioide; DDMOH =

Distancia de Deslocamento Maximo do Osso Hioide; VEL = velocidade.

DISCUSSAO

A USG é um método alternativo acessivel para uma avaliagcdo complementar

da degluticdo, que tem sido utilizada de formas diferentes a depender dos objetivos

a serem cumpridos, como a USG em posi¢cao submentoniana e a USGLT (HSIAO et



23

al., 2012; LYNCH et al., 2008; OH et al., 2016). A garantia de mais confiabilidade e
precisdo da analise desses exames surge a partir da utilizacdo de métodos e
instrumentos capazes de extrair medidas quantitativas de amplitude, tempo e
velocidade do deslocamento hioideo (BACELETE; VICENTE; SANTOS, 2016; CHEN
et al., 2017; LEE et al.,, 2016). Para isto, a criagdo de novos metodos necessita
também da analise de concordancia a fim de torna-los reprodutiveis.

A pesquisa de Chen et al. (2017) avaliou o deslocamento do osso hioide por
meio da USG submentoniana. Os pesquisadores adotaram apenas uma medida
referente a distancia maxima do movimento do osso hioide ao deglutir e calcularam
os CCIl a partir dos exames de 10 pacientes com comorbidades diferentes. Os
coeficientes encontrados foram satisfatorios: 0.99 e 0.95 entre dois avaliadores, 0.89
na analise intra-avaliadores e 0.81 e 0.91 comparando USG e VFD. Este é um dos
poucos estudos que possuem foco na analise de confiabilidade de mensuracdes do
deslocamento hioideo. Apesar disso, compara-lo diretamente com os resultados
encontrados no presente estudo néo foi possivel em virtude da diferenca entre os
métodos.

Os resultados deste estudo demonstraram que as medidas de deslocamento do
0sso hioide por USGLT tiveram, na sua maioria, concordancia boa na anadlise intra-
avaliador e moderada na andlise interavaliadores. Embora possa ser considerado
aceitavel, esse resultado aponta para a necessidade de melhorar a confiabilidade
das mensuragbes com concordancias mais robustas e mais precisdo das
estimativas, ja que a amplitude dos intervalos de confianca foi elevada.

O fato de a concordancia intra-avaliador ter apresentado estimativas mais
confiaveis quando comparada a concordancia entre avaliadores nas medidas

pesquisadas sinaliza que, na pratica, € mais confiavel obter os resultados a partir da
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meédia das analises de um mesmo avaliador do que a partir da média de avaliadores
diferentes. Salienta-se o impacto das diferencas interindividuais € menor quando a
unidade de comparacéo do avaliador € ele préprio.

Em contraponto, vale ressaltar que na analise intra-avaliador observaram-se
discrepancias no padréo de distribuicdo dos coeficientes ao comparar os trés juizes,
ou seja, ainda que treinados previamente os avaliadores parecem ter adotado uma
padronizacao individual de andlise, fato que interfere negativamente nas estimativas
de concordancia. Nesse caso, recomenda-se investir no aprimoramento das
estratégias de treinamento para garantir a todos os avaliadores a uniformizacéo das
referéncias para andlise das medidas. E possivel que o treinamento oferecido neste
estudo nao tenha sido suficiente ou adequado para atender esse requisito.

Nesse sentido, um estudo mostrou a relevancia da curva de aprendizagem
para melhorar o desempenho de residentes na realizacdo de USGLT para avaliacao
da mobilidade de pregas vocais (WONG et al., 2015). Eles melhoraram suas
habilidades apés a 72 analise e apos a 412 andlise houve diminui¢cdo do tempo para
realizacdo do exame e de resultados falsos negativos. No presente estudo foram
avaliados 48 exames, numero que pode nao ter sido suficiente para aumentar a
curva de aprendizagem, algo que devera ser aperfeicoado nos préximos estudos.

Também é necessario refletir sobre o rigor no controle da relagdo entre
guantidade de exames analisados e tempo dedicado a essa tarefa. Para ser
realizada com eficiéncia, a analise de imagens ultrassonograficas necessita de
tempo e precisdo (WONG et al., 2015). Isso porque essas mensuracdes tém um
componente perceptivo-visual que pode ser prejudicado caso muitos exames sejam
analisados em um curto espaco de tempo. Tal fato pode ter ocorrido com o juiz 2,

notadamente o que apresentou pior desempenho na analise intra-avaliador.
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As medidas com baixas estimativas de concordancia interavaliadores
estavam relacionadas as medidas de amplitude do movimento e retorno do 0sso
hioide ao repouso. Essas mesmas medidas também apresentaram padrbes
diferenciados entre os trés juizes na analise intra-avaliador. Esse resultado indica
mais uma vez que 0s juizes podem ter usado pontos de ancoragem distintos na
analise dessas medidas e que, portanto, o modelo de treinamento para obté-las
deve ser revisto.

Quanto as medidas de amplitude esperava-se que as estimativas fossem
mais consistentes considerando os resultados de estudos como o de Chen et al.
(2017) com medidas dessa natureza. Vale ponderar que dois juizes ja tinham
experiéncia prévia com a obtencdo das medidas temporais, porém tinham menos
experiéncia nas medidas de amplitude. Além disso, as mensuracfes de tempo e
amplitude possuem estratégias de aquisicdo diferentes. Esses aspectos podem
ajudar a explicar desempenho mais satisfatério nas analises de concordancia de
medidas temporais e os coeficientes mais baixos nas medidas de amplitude.

Em relacdo as medidas temporais de retorno, o resultado ratifica que o
regresso do 0sso hioide a uma posicao estavel ao fim da degluticdo € uma dimenséao
gue apresenta muitas variacdes, tornando dificil de ser realizada uma medicao
precisa, podendo até mesmo ser desconsiderada em alguns estudos (KENDALL et
al., 2000). De acordo com o relato dos juizes deste estudo, determinar o quadro final
que representa o retorno do 0sso hioide ao repouso foi uma tarefa dificil.

Enquanto isso, a medida de velocidade, que é resultado da razdo entre os
valores de DDMOH por TDMOH, apresentou resultados prioritariamente bons na
avaliacdo intravaliadores e moderados na analise interavaliadores. Esse resultado

precisa ser observado com cautela, pois a medida de velocidade € composta por
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duas outras medidas que isoladamente apresentaram comportamentos divergentes,
sendo o TDMOH mais satisfatorio que o DDMOH. Portanto, as estimativas
encontradas podem ter sido influenciadas por essa configuracao.

Dentre as medidas pesquisadas, TEOH e TDMOH apresentaram
desempenho mais consistente nas analises de concordancia intra e interavaliadores.
Esse resultado demonstra que dentre todas as medidas, a elevacdo do 0sso hioide
parece ser 0 evento de visualizacdo mais facil na USGLT. Ja o TDMOH resulta da
combinacdo de elevacdo e anteriorizacdo e representa 0 tempo total que 0 0Sso
hioide leva do repouso ao seu ponto maximo de deslocamento. Assim como
comentado anteriormente sobre a medida de velocidade, esse resultado precisa ser
interpretado com parcimonia, especialmente o TDMOH, pois houve um desequilibrio
entre as duas medidas que o compdem (TEOH e TAOH) e a medida com
desempenho mais satisfatorio (TEOH) pode ter interferido na estimativa encontrada.

Embora a confiabilidade e precisdo das medidas investigadas neste estudo
precisem melhorar, os resultados mostram que a USGLT é um procedimento
promissor para analise do deslocamento do osso hioide durante a degluticdo.
Algumas alternativas como o reconhecimento automético do osso hioide (deep
learning) a partir das imagens geradas pela USGLT ja estdo em andamento no
grupo de pesquisa, alinhado ao que ja vem sendo proposto na literatura com VFD
(ZHANG, COYLE, SEJDIC, 2018).

Destarte, a pesquisa possui algumas limitacbes. O numero de imagens
reduzido pode ter interferido no resultado, assim como a auséncia de um
treinamento mais controlado dos avaliadores e o fato de os exames serem apenas

de mulheres sem queixa de degluticdo. Proximos estudos deverdo minimizar essas

limitacGes.
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CONCLUSAO

A analise de concordancia intra e interavaliadores apresenta resultados que
variam entre baixa e excelente confiabilidade, com destaque para confiabilidade
moderada na analise intra-avaliador e boa na analise interavaliadores. A
concordancia intra-avaliador possui estimativas mais confiaveis quando comparada
a concordancia entre avaliadores, mas ambas apresentam pouca precisdo. As
medidas temporais sdo as mais confidveis, especialmente o tempo de elevacédo e o

tempo de deslocamento maximo do 0sso hioide.
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